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(Figures/Text)

This chapter provides an overview of the draw/edit tools and how to draw figures and text in 
GP-Pro EX. 
Read  “9.1 Settings Menu” (page 9-2)  first, then skip to the explanations as required.

9.1 Settings Menu .................................................................................................9-2
9.2 Drawing Pictures .............................................................................................9-6
9.3 Writing Text ...................................................................................................9-23
9.4 Editing Objects ..............................................................................................9-26
9.5 Changing Colors, Line Types and Patterns...................................................9-34
9.6 Editing a Part.................................................................................................9-38
9.7 Using a Screen for Various Purposes ...........................................................9-50
9.8 Editing a Picture on Another Screen .............................................................9-53
9.9 Creating a Screen from a Template ..............................................................9-57
9.10 Pasting an Image ..........................................................................................9-63
9.11 Drawing a Detailed Picture............................................................................9-66
9.12 Settings Guide...............................................................................................9-77
9.13 Restrictions ...................................................................................................9-84



Settings Menu

GP-Pro EX Reference Manual 9-2

9.1 Settings Menu

Drawing Pictures

Draws a line, rectangle, and other pictures.

 “9.2.1 Drawing Picture Lists” 
(page 9-6) 

Writing Text

Places text on the screen.

Setting Procedure (page 9-23)

Production Inventory 
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Editing Objects

Runs screen edit operations such as enlarging, reducing 
or moving.

 “9.4.1 Introducing Edit Tools” 
(page 9-26) 

Changing Colors, Line Types and Patterns

Changes a picture's color, line type, and pattern.

 “9.5 Changing Colors, Line 
Types and Patterns” (page 9-34) 

Editing a Part

Changes the shape, color, and label of a part.

 “9.6.1 Editing Parts” (page 9-38) 

Handle 

Handle 

Drag it to a desired position. 

Drag it to a desired size. 

Enlarging/Reducing 

Moving an Object 

Lamp 

Edit 

Start 
ON 

Stop 
OFF 



B1 

Setting Input Screen Active Operations Screen Active Monitoring Screen Alarm Screen 

B2 

Setting Input Screen Active Operations Screen Active Monitoring Screen Alarm Screen 

B3 

Setting Input Screen Active Operations Screen Active Monitoring Screen Alarm Screen 

Setting Input  
Screen 

Active Operations
Screen

Active Monitoring 
Screen 

B100 

Setting Input Screen Active Operations Screen Active Monitoring Screen Alarm Screen 

Create a screen for various 
purposes. 

You can call and display 
various screens. 

Call Screen 

Package

Drag and Drop

Objects registered in 
a package

Place it on the screen and edit it.
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Using a Screen for Various Purposes

Setting Procedure (page 9-50)

Editing a Picture on Another Screen

 “9.8.1 Placing Pictures 
Registered in the Package” 
(page 9-53) 
 “9.8.2 Registering Pictures in the 
Package” (page 9-55) 

Setting up Grids

Displays an equally spaced grid on the editing screen 
and places parts with reference to an intersecting point.

Setting Procedure (page 9-57)
Detail (page 9-57)

Menu Screen 
Setting Input 

Screen 
Active Operations 

Screen 

Active Monitoring 
Screen Alarm Screen 



Converts image data and 
places it on the screen. 

BMP, JPEG, etc. 
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Selecting a Screen from Template

Edits screens from a template screen.

 “9.9.2 Selecting a Screen from 
Template” (page 9-60) 

Pasting an Image

Setting Procedure (page 9-64)
Target Image (page 9-63)

Drawing a Detailed Picture

Draws a picture pixel by dot.

Setup Procedure (page 9-66)
Introduction (page 9-66)

Select a template. 

Screen Image 3 

Template List 

Screen 
Image 1 

Screen
Image 2

Screen
Image 3

Screen
Image 4

Screen
Image 5

Screen
Image 6
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9.2 Drawing Pictures

9.2.1 Drawing Picture Lists

9.2.2 Drawing by Pixels

The Dot feature can draw one to five dots at a time.
From the [Draw (D)] menu, select [Dot (D)] command or click  to place a dot on the 
screen. If you click  and double-click the placed [Dot], the following dialog box appears.

For display colors, refer to  “9.5.1 Setting Colors” (page 9-34) 
For blinking, refer to  “9.5.2 Setting Blinks” (page 9-37) 

Picture Description

Dot Draws a dot.
 “9.2.2 Drawing by Pixels” (page 9-6) 

Line/
Polyline

Draws a line/polyline.
 “9.2.3 Drawing Line/Polyline” (page 9-7) 

Rectangle Draws a rectangle.
 “9.2.4 Drawing Rectangles” (page 9-8) 

Polygon Draws a polygon.
 “9.2.7 Drawing Polygons” (page 9-16) 

Circle/Oval Draws a circle/oval.
 “9.2.5 Drawing Circles/Ovals” (page 9-11) 

Arc/Pie Draws an arc/pie.
 “9.2.6 Drawing Arcs/Pies” (page 9-14) 

Scale Draws the graph scales.
 “9.2.8 Drawing Scales” (page 9-18) 

Table Draws a table.
 “9.2.9 Drawing Tables” (page 9-20) 
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9.2.3 Drawing Line/Polyline

Drag the mouse to draw a line from the start to the end. For the polyline, click to designate 
the start, the mountain fold and the end, and right-click to set.
From the [Draw (D)] menu, select [Line (L)] or [Polyline (U)], or click  or  to place a 
line/polyline on the screen. If you click  and double-click the placed [Line] or [Polyline], 
the following dialog box appears.

• If you press and hold the [Shift] key while placing a line, you can draw a line 
at an angle of 0 degrees and 90 degrees.

• If you place a line while pressing the [Ctrl] key, you can draw a line 
extending from the center. If you place a line while pressing the [Ctrl] and 
[Shift] keys at the same time, you can draw a line of 0 degrees or 90 degrees 
extending from the center.

• To edit after placing the line and polyline, click on the selected line to change 
to a yellow handle. You can drag the line to change the shape.

• For a polyline, you can left click and drag to draw, similar to handwriting.

Setting Description
Line Type Select the line type from [Solid Line], [Dotted Line], [Dash Line], [Chain 

Line], or [Two-Dot Chain Line].
 “9.5.3 Setting Line Types” (page 9-37) 

Line Thickness Set the line thickness within the range of one to nine dots.

• When line types other than [Solid Line] are selected in [Line Type], the 
setting range is one to two dots.

Arrow Shape Select the arrow shape from , , ,  or .

Arrow Direction Select the arrow direction from [Start], [End], or [Both Ends].
Display Color Set the line color.

 “9.5.1 Setting Colors” (page 9-34) 
Pattern Color Select the pattern color. This function can be used only when line types 

other than [Solid Line] are selected in [Line Type].
Continued
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9.2.4 Drawing Rectangles

Draw a rectangle by dragging the mouse to specify two opposite corners.
In the [Draw (D)] menu, select [Rectangle (R)] or click  to place a rectangle on the 
screen.

Double-click the placed [Rectangle] to display the following dialog box.

Blink Select whether or not the Part will blink, and the blink speed. You can 
choose different blink settings for [Display Color] and [Pattern Color] of 
the part.

• There are cases where you can and cannot set Blink depending on the 
Display and System Settings [Color Settings].

 “9.5.1 Setting Colors” (page 9-34) 

• If you press and hold the [Shift] key while drawing a rectangle, the object is 
forced into a square.

• If you place a rectangle while pressing the [Ctrl] key, you can draw a 
rectangle spreading out from the center. If you place a rectangle while 
pressing the [Ctrl] and [Shift] keys at the same time, you can draw a square 
spreading out from the center.

Setting Description
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Setting Description
Border Line Type Select the line type from [Solid Line], [Dotted Line], [Dash Line], 

[Chain Line], or [Two-Dot Chain Line].
 “9.5.3 Setting Line Types” (page 9-37) 

Line 
Thickness

Set the line thickness within the range of one to nine dots.

• When other line types than [Solid Line] are selected in [Line Type], 
the line thickness is fixed at one dot.

Display Color Set the border color.
 “9.5.1 Setting Colors” (page 9-34) 

Pattern Color Select the pattern color. This function can be used only when line 
types other than [Solid Line] are selected in [Line Type].

 “9.5.4 Setting Patterns” (page 9-37) 
Blink Select whether or not the Part will blink, and the blink speed. You can 

choose different blink settings for the [Display Color] and [Pattern 
Color] of the part.

• There are cases where you can and cannot set Blink depending on 
the Display and System Settings [Color Settings].

 “9.5.1 Setting Colors” (page 9-34) 
Continued
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Fill Pattern Set a background pattern for the rectangle.
 “9.5.4 Setting Patterns” (page 9-37) 

Display Color Set a color for the rectangle.
 “9.5.1 Setting Colors” (page 9-34) 

Pattern Color Set the background pattern color for the rectangle.
 “9.5.4 Setting Patterns” (page 9-37) 

Blink Select whether or not the Part will blink, and the blink speed. You can 
choose different blink settings for the [Display Color] and [Pattern 
Color] of the part.

• There are cases where you can and cannot set Blink depending on 
the Display and System Settings [Color Settings].

 “9.5.1 Setting Colors” (page 9-34) 
Shadow Direction Select the shadow direction from [Top Left], [Bottom Left], [Top 

Right], or [Bottom Right].
Color Set the shadow color.

 “9.5.1 Setting Colors” (page 9-34) 
Shadow 
Distance

Set the width of the picture and the shadow within the range of 1 to 
16.

Chamfer Select the chamfer shape from [None], [Line], or [Circle].
Number of Dots Designate the number of dots for chamfer from 1 to 999.

Setting Description

Set the number of dots in this space. 
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9.2.5 Drawing Circles/Ovals

Draw a circle or oval by dragging the mouse to specify the center point and one point on the 
circle.
From the [Draw (D)] menu, select [Circle/Oval (C)] or click  to place a circle/oval on the 
screen. If you double-click the placed [Circle/Oval], the following dialog box appears.

• If you press and hold the [Shift] key while placing an object, you can draw a 
circle.

• If you place a circle/oval while pressing the [Ctrl] key, you can draw a circle/
oval spreading out from the center. If you place a circle/oval while pressing 
the [Ctrl] and [Shift] keys at the same time, you can draw a circle spreading 
out from the center.
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Setting Description
Border Line Type Select the line type from [Solid Line], [Dotted Line], [Dash Line], 

[Chain Line], or [Two-Dot Chain Line].
 “9.5.3 Setting Line Types” (page 9-37) 

Line 
Thickness

Set the line thickness within the range of one to nine dots.

• When other line types than [Solid Line] are selected in [Line Type], 
the line thickness is fixed at one dot.

Display Color Set the border color.
 “9.5.1 Setting Colors” (page 9-34) 

Pattern Color Select the pattern color. This function can be used only when line 
types other than [Solid Line] are selected in [Line Type].

 “9.5.4 Setting Patterns” (page 9-37) 
Blink Select whether or not the Part will blink, and the blink speed. You can 

choose different blink settings for the [Display Color] and [Pattern 
Color] of the part.

• There are cases where you can and cannot set Blink depending on 
the Display and System Settings [Color Settings].

 “9.5.1 Setting Colors” (page 9-34) 
Continued
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Fill Pattern Set the background pattern for the circle/oval.
 “9.5.4 Setting Patterns” (page 9-37) 

Display Color Set a color for the circle/oval.
 “9.5.1 Setting Colors” (page 9-34) 

Pattern Color Set the background pattern color for the circle/oval.
 “9.5.4 Setting Patterns” (page 9-37) 

Blink Select whether or not the Part will blink, and the blink speed. You can 
choose different blink settings for the [Display Color] and [Pattern 
Color] of the part.

• There are cases where you can and cannot set Blink depending on 
the Display and System Settings [Color Settings].

 “9.5.1 Setting Colors” (page 9-34) 
Shadow Direction Select the shadow direction from [Top Left], [Bottom Left], [Top 

Right], or [Bottom Right].
Color Set the shadow color.

 “9.5.1 Setting Colors” (page 9-34) 
Shadow 
Distance

Set the width of the circle/oval and the shadow within the range of 1 
to 16.

• You can set the width and height of a circle/oval in the [Properties (P)]. 
However, if you set the width or height to an even number, it will be drawn 
with one less dot on the GP.

Setting Description

Height, width 100 dots 

In GP-Pro EX 

(99,99) 

(0,0) 

Height, width 99 dots 

On the GP 

(99,98) 

(0,0) 
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9.2.6 Drawing Arcs/Pies

Draw an arc or pie by dragging the mouse to specify the center point and one point on the 
circle, and specify the start angle and end angle in the dialog box. You can select an arc or 
pie.
From the [Draw (D)] menu, select [Arc/Pie (A)] or click  to place an arc/pie on the 
screen. If you click  and double-click the placed [Arc/Pie], the following dialog box 
appears.

• If you press and hold the [Shift] key while placing an object, you can draw a 
circle arc.

• If you place an arc/pie while pressing the [Ctrl] key, you can draw a circle/
oval's arc spreading out from the center. If you place an arc/pie while 
pressing the [Ctrl] and [Shift] keys at the same time, you can draw a circle's 
arc spreading out from the center.

• If you edit an arc/pie after placing it, you can change the arc/pie's start angle 
and end angle by operating the yellow handle in the selected state.

• You can set the width and height of an arc/pie in the [Properties (P)]. 
However, if you set the width or height to an even number, it will be drawn 
with one less dot on the GP.



Drawing Pictures

GP-Pro EX Reference Manual 9-15

Setting Description
Border Line Type Select the line type from [Solid Line], [Dotted Line], [Dash Line], 

[Chain Line], or [Two-Dot Chain Line].
Line 
Thickness

Set the line thickness within the range of one to nine dots.

• When other line types than [Solid Line] are selected in [Line Type], 
the line thickness is fixed at one dot.

Display Color Set the arc/pie border color.
Pattern Color Select the pattern color. This function can be used only when line 

types other than [Solid Line] are selected in [Line Type].
Blink Select whether or not the Part will blink, and the blink speed. You can 

choose different blink settings for the [Display Color] and [Pattern 
Color] of the part.

• There are cases where you can and cannot set Blink depending on 
the Display and System Settings [Color Settings].

 “9.5.1 Setting Colors” (page 9-34) 
Fill Pattern Select a background pattern for the pie.

Display Color Set the pie's color.
Pattern Color Set the background pattern color for the pie.
Blink Select whether or not the Part will blink, and the blink speed. You can 

choose different blink settings for the [Display Color] and [Pattern 
Color] of the part.

• There are cases where you can and cannot set Blink depending on 
the Display and System Settings [Color Settings].

 “9.5.1 Setting Colors” (page 9-34) 
Shadow Direction Select the shadow direction from [Top Left], [Bottom Left], [Top 

Right], or [Bottom Right].
Color Set the shadow color.
Shadow 
Distance

Set the width of the arc/pie and its shadow within the range of 1 to 16.

Arc/Pie Select from [Arc] or [Pie].
Start Angle/End Angle Set the [Start Angle] or [End Angle].
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9.2.7 Drawing Polygons

To draw a polygon, click each apex and right-click to define a polygon.
From the [Draw (D)] menu, select [Polygon (P)] or click  to place a polygon on the 
screen. If you click  and double-click the placed [Polygon], the following dialog box 
appears.

• To edit a polygon, click on a line in the polygon to change to a yellow handle. 
You can drag a line on the polygon to change the shape.

Setting Description
Border Line Type Select the line type from [Solid Line], [Dotted Line], [Dash Line], 

[Chain Line], or [Two-Dot Chain Line].
 “9.5.3 Setting Line Types” (page 9-37) 

Line 
Thickness

Set the line thickness within the range of one to nine dots.

• When other line types than [Solid Line] are selected in [Line Type], 
the line thickness is fixed at one dot.

Display Color Set the border color.
 “9.5.1 Setting Colors” (page 9-34) 

Pattern Color Select the pattern color. This function can be used only when line 
types other than [Solid Line] are selected in [Line Type].

 “9.5.4 Setting Patterns” (page 9-37) 
Blink Select whether or not the Part will blink, and the blink speed. You can 

choose different blink settings for the [Display Color] and [Pattern 
Color] of the part.

• There are cases where you can and cannot set Blink depending on 
the Display and System Settings [Color Settings].

 “9.5.1 Setting Colors” (page 9-34) 
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Continued
Fill Pattern Set a background pattern for the polygon.

 “9.5.4 Setting Patterns” (page 9-37) 
Display Color Set a color for the polygon.

 “9.5.1 Setting Colors” (page 9-34) 
Pattern Color Set a background pattern's color for the polygon.

 “9.5.4 Setting Patterns” (page 9-37) 
Blink Select whether or not the Part will blink, and the blink speed. You can 

choose different blink settings for the [Display Color] and [Pattern 
Color] of the part.

• There are cases where you can and cannot set Blink depending on 
the Display and System Settings [Color Settings].

 “9.5.1 Setting Colors” (page 9-34) 
Shadow Direction Select the shadow direction from [Top Left], [Bottom Left], [Top 

Right], or [Bottom Right].
Color Set the shadow color.

 “9.5.1 Setting Colors” (page 9-34) 
Shadow 
Distance

Set the width of the polygon and its shadow within the range of 1 to 
16.

Setting Description
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9.2.8 Drawing Scales

Draw a scale by dragging to specify two opposite corners. Set the divisions of the scale in the 
following dialog box.
From the [Draw (D)] menu, select [Scale (S)] or click  to place a scale on the screen. If 
you click  and double-click the placed [Scale], the following dialog box appears.

• To edit a scale after placing it, click the line in the selected state to make it a 
yellow handle. You can change the scale type by operating the yellow handle 
axis.

Setting Description
Scale Line Type Select the line type from [Solid Line], [Dotted Line], [Dash Line], 

[Chain Line], or [Two-Dot Chain Line].
 “9.5.3 Setting Line Types” (page 9-37) 

Line 
Thickness

Set the line thickness within the range of one to nine dots.

• When line types other than [Solid Line] are selected in [Line Type], 
the setting range is one to two dots.

Display Color Select the scale color.
 “9.5.1 Setting Colors” (page 9-34) 

Pattern Color Select the pattern color. This function can be used only when line 
types other than [Solid Line] are selected in [Line Type].

 “9.5.4 Setting Patterns” (page 9-37) 
Blink Select whether or not the Part will blink, and the blink speed. You can 

choose different blink settings for the [Display Color] and [Pattern 
Color] of the part.

• There are cases where you can and cannot set Blink depending on 
the Display and System Settings [Color Settings].

 “9.5.1 Setting Colors” (page 9-34) 
Continued
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Major 
Scale

Divisions Select from 1 to 999 large-scale axis divisions.

Length Select the large scale length from 2 to 3,072.
Minor 
Scale

Divisions Select from 2 to 999 minor-scale axis divisions.

Length Select the minor scale length from 1 to 3,071.
Draw 
Axis

Axis Position Select the scale direction from the axis from [Left] or [Right].

Type Bar (Vertical) Displays the scale for a vertical bar graph.
Bar 
(Horizontal)

Displays the scale for a horizontal bar graph.

Arc Displays the scale for a circle graph.

• You can set the width and height of a scale in [Edit (E)], [Change 
Attributes (M)]. However, if you set the width or height to an even 
number, it will be drawn with one less dot on the GP.

Start Angle/End Angle Set the [Start Angle] or [End Angle].

Setting Description

Large Scale 

Minor Scale 
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9.2.9 Drawing Tables

Draw a table by dragging to specify two opposite corners. Set the rungs and number of 
columns in the following dialog box.
From the [Draw (D)] menu, select [Table (T)] or click  and to place a table on the screen. 
If you double-click the placed [Table], the following dialog box appears.

• To edit the table after placing it, click a line of the table in the selected state 
to make it a yellow handle. You can change the inside border spacing by 
operating the yellow handle.

• When you click this icon, drag to select the table frame borders and 
move the pointer  to the drawing area to place the defined table.
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Setting Description
Show 
Border

Line Type Select the line type from [Solid Line], [Dotted Line], [Dash Line], 
[Chain Line], or [Two-Dot Chain Line].

 “9.5.3 Setting Line Types” (page 9-37) 
Line 
Thickness

Set the line thickness within the range of one to nine dots.

• When other line types than [Solid Line] are selected in [Line Type], 
the line thickness is fixed at one dot.

Display Color Set the outer border color for the table.
 “9.5.1 Setting Colors” (page 9-34) 

Pattern Color Select the pattern color. This function can be used only when line 
types other than [Solid Line] are selected in [Line Type].

 “9.5.4 Setting Patterns” (page 9-37) 
Blink Select whether or not the Part will blink, and the blink speed. You can 

choose different blink settings for the [Display Color] and [Pattern 
Color] of the part.

• There are cases where you can and cannot set Blink depending on 
the Display and System Settings [Color Settings].

 “9.5.1 Setting Colors” (page 9-34) 
Inside 
Border

Line Type Select the line type from [Solid Line], [Dotted Line], [Dash Line], 
[Chain Line], or [Two-Dot Chain Line].

 “9.5.3 Setting Line Types” (page 9-37) 
Line 
Thickness

Set the line thickness within the range of one to nine dots.

• When other line types than [Solid Line] are selected in [Line Type], 
the line thickness is fixed at one dot.

Display Color Set the inside border color for the table.
 “9.5.1 Setting Colors” (page 9-34) 

Pattern Color Select the pattern color. This function can be used only when line 
types other than [Solid Line] are selected in [Line Type].

 “9.5.4 Setting Patterns” (page 9-37) 
Blink Select whether or not the Part will blink, and the blink speed. You can 

choose different blink settings for the [Display Color] and [Pattern 
Color] of the part.

• There are cases where you can and cannot set Blink depending on 
the Display and System Settings [Color Settings].

 “9.5.1 Setting Colors” (page 9-34) 
Continued
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Fill Pattern Select a background pattern for the table.
 “9.5.4 Setting Patterns” (page 9-37) 

Display Color Set the table color.
 “9.5.1 Setting Colors” (page 9-34) 

Pattern Color Set the background pattern color for the table.
 “9.5.4 Setting Patterns” (page 9-37) 

Blink Select whether or not the Part will blink, and the blink speed. You can 
choose different blink settings for the [Display Color] and [Pattern 
Color] of the part.

• There are cases where you can and cannot set Blink depending on 
the Display and System Settings [Color Settings].

 “9.5.1 Setting Colors” (page 9-34) 
Pixels Between Select from [Equal Spacing] or [Free].

• Equal Spacing
The row width and column width are made equal.

• Free
The row width and column width can be adjusted freely.

Divisions Designate the number of rows [Vertical] and number of columns 
[Horizontal] in the table from 1 to 30.

Setting Description
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9.3 Writing Text

Draw text on the drawing screen.
To draw text in order to switch the screen display languages or display content while 
operating the GP, use a text table. For the settings, refer to “15.4 Changing Languages 
(Multilanguage)” (page 15-16) .

9.3.1 Setup Procedure

To place the text "Production Inventory" on the drawing screen.

1 From the [Draw (D)] menu, select [Text (S)] or click  to place text on the screen.

• Please refer to the settings guide for details.
 “9.12.1 Text Settings Guide” (page 9-77) 

Production Inventory 
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2 In the toolbar, click the pointer icon  and select the placed text. When the text border 
appears, drag to adjust its size and position.

3 Double-click the placed text and the [Text] dialog box appears.
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4 Designate the font and size and input text to place in the Input Text border.

5 Click [OK] and the input text "Production Inventory" will be placed.
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9.4 Editing Objects

9.4.1 Introducing Edit Tools

Setting Description
Cut Cut the object (Parts, Text, Figure). You can place the cut 

object on the screen with [Paste].

Operation Procedure
You can cut an object by selecting a desired object and click 
[Cut] in the [Edit] menu.

Copy Copies the selected object. Place it on the screen by using the 
[Paste].

Operation Procedure
You can copy by selecting a desired object and click [Copy] in 
the [Edit] menu.

Paste Pastes the copied or cut object onto a screen.

Operation Procedure
You can paste the object you copied or cut by clicking [Paste] 
in the [Edit] menu.

• When pasting from one screen to another, you can paste the 
object to the same position as the other screen.

Duplicate Copies multiple pictures at a time. When duplicating parts, you 
can automatically assign the next consecutive address after the 
source part's address to the destination part.

 “9.4.5 Duplicate” (page 9-28) 
Delete Deletes an object.

Operation Procedure
You can delete by selecting the desired object and clicking 
[Delete (D)] in the [Edit] menu.

Select All Selects all the objects on the screen.
You can also specify the range to drag multiple objects.

 “9.4.2 Selection Method” (page 9-27) 
Edit Vertex You can edit, delete or insert each vertex coordinate of a 

polyline or polygon.
 “  Edit Vertex” (page 9-30) 

Group You can group multiple objects together and treat them as one 
unit.

 “9.4.7 Grouping (Ungrouping)” (page 9-31) 
Order You can change the order of placed overlapping objects.

 “9.4.8 Order” (page 9-31) 
Continued
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9.4.2 Selection Method

There are two ways to select an object: click the object directly or specify the range to drag 
multiple surrounding objects.

9.4.3 Enlarging and Reducing the Size

Select the target object and hover the cursor on the handle. When the cursor turns to , you 
can zoom in or out and drag the object to the appropriate size.

Place/
Align

You can adjust the positions of multiple objects (Align Right, 
Align Left, Align Center, etc.).

 “9.4.9 Aligning” (page 9-32) 

Rotate/
Flip

• Rotate
Rotates the object by 90 degrees.

 “9.4.10 Rotating Right or Left” (page 9-32) 
• Flip

Flips the object horizontally or vertically.
 “9.4.11 Reversing X-Axis (Vertical)/Y-Axis (Horizontal)” (page 9-33) 

Others Sets a grid and guidelines to align a part with another one.
 “9.9 Creating a Screen from a Template” (page 9-57) 

• To select one of the overlapping objects, click the object while pressing the 
[Ctrl] key. Each object becomes in the selective state in turn, and you can 
select the target object.

• To release a particular object from the selected objects, click the target object 
while pressing the [Shift] key.

• To add a particular object to the selected objects, click the target object while 
pressing the [Shift] key.

• If you select an object and move the four-cornered handles while pressing the 
[Shift] key, you can enlarge/reduce it with the same horizontal to vertical 
ratio.

• If you use the [↑], [→], [←], and [↓] keys with the cursor on the object 
handle, you can enlarge/reduce the object by the dot.

Setting Description

Handle 

Drag it to a desired size. 
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9.4.4 Moving Objects

Select the target object and hover the cursor on the object. When the cursor turns to , you 
can drag the object to the appropriate location.

9.4.5 Duplicate

Copies multiple pictures at a time.
Right-click while selecting the object and click [Duplicate (W)].

• If you move while pressing the [Shift] key, you can move the object 
horizontally or vertically.

• If you use the [↑], [→], [←], and [↓] keys with the object selected, you can 
move the object a dot at a time.

• When duplicating parts, you can automatically assign the next consecutive 
address after the source part's address to the destination part.

Handle 

Drag it to a desired position. 
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Duplicate Description
• In X Direction

Set the number of display positions in the X direction from 1 
to 99.

• Pixels Between
Set the number of dots between objects from 1 to 99 dots.

• In Y Direction
Set the number of display positions in the Y direction from 1 
to 99.

• Pixels Between
Set the number of dots between objects from 1 to 99 dots.

• Direction of Copies
Select the display direction from , , , , , 

,  or .

• When you add addresses, sequential addresses are assigned 
in the specified direction according to the address addition 
width.

• Duplicate Comment
The copy source comment is reflected in the copy 
destination.

• Mouse defines the range
Using the defined interval, makes copies that fit into the 
range.

• The minimum settings range depends on the size of the parts 
of the copy source and the number of copies. You cannot 
move the cursor to this range.

• Assign Addresses
You can assign sequential addresses from the copy-from 
addresses according to the [Increment Each Address by].

• Increment Each Address by
Designates an address interval. When the copy-from 
addresses are Bit addresses, addresses are added by the Bit. 
When the copy-from addresses are Word addresses, 
addresses are added by the Word.

• Assign Individual Addresses
When multiple addresses are set to one object, you can 
designate whether or not to add each address.
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9.4.6 Changing Attributes

You can change object attributes such as color or address.
To change attributes, double-click the object while selecting it or select [Change Attributes 
(M)] from the [Edit] menu.

Edit Vertex
You can edit, delete, or insert each vertex coordinate of a polyline or polygon.
To edit the object's vertex, click a line in the selected state to change it to a yellow handle. 
Change the shape of the object by clicking an arbitrary line. To delete the vertex, right-click 
on the vertex and select [Delete Vertex].

• When multiple objects are selected, you cannot change attributes.
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9.4.7 Grouping (Ungrouping)

You can group multiple objects and handle them as one object. To do so, select multiple 
objects, right-click, and click [Group (E)]. To ungroup, click [Ungroup (G)].

9.4.8 Order

When the placed objects are overlapping, you can change the placement order. Select and 
right-click the object whose order you want to change, click [Order (O)], and select the object 
order from [Bring to Front], [Send to Back], [Move Forward], or [Move Backward]. In the 
following example, the oval is moved backward.
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9.4.9 Aligning

You can align the position of multiple objects. Select the objects that you want to align, right-
click, and then select [Align Left (L)], [Right (R)], [Top (T)], [Bottom (B)], [Align Center 
(Horizontal) (C)], [Align Center (Vertical) (M)], or [Others (E)] from [Place/Align (A)]. In 
the following example, the rectangle, polygon, and circle are all aligned to the top.

9.4.10 Rotating Right or Left

You can rotate the object to the right and left 90 degrees at a time. Right click to select the 
object you want to rotate, select the [Rotate Right (E)], [Rotate Left (I)] in [Rotate/Flip (R)]. 
The following example describes placement of a right-rotated polygon.
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9.4.11 Reversing X-Axis (Vertical)/Y-Axis (Horizontal)

You can flip the object on the X-Axis (vertical) or the Y-Axis (horizontal) of the center line 
of the object. Right-click to select the desired object and select [Flip Horizontal (H)] or [Flip 
Vertical (V)] from the [Rotate/Flip (R)]. The following example shows the position of a 
polygon flipped horizontally. Please note that only the display position of the screen, marks, 
parts, and text are reflected.

9.4.12 Changing Coordinates

You can change the position and size of an object by designating a coordinate in the 
[Properties (P)]. The reference of the coordinate is the top left of an object.

• If the [Properties] tab is not displayed in either the work space or the screen 
drawing area, from the [View (V)] menu, point to [Work Space (W)] and 
select [Properties (P)].
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9.5 Changing Colors, Line Types and Patterns

9.5.1 Setting Colors

List of Available Colors

Model Display Device Display Color Designated Number of 
Colors in Drawing

AGP-3200T TFT Color LCD 256 Colors, None Blink
64 Colors, 3-Speed Blink

256 Colors
64 Colors

AGP-3200A Monochrome LCD 8 Levels, 1-Speed Blink Monochrome 8 Levels
AGP-3302B Blue-mode 

Monochrome LCD
16 Levels, 3-Speed Blink 16 Levels

AGP-3301L Monochrome LCD Monochrome, 16 Levels, 3-
Speed Blink

Monochrome 16 Levels

AGP-3301S STN Color LCD 4096 Colors, 3-Speed Blink 256 Colors
AGP-3300L Monochrome LCD Monochrome, 16 Levels, 3-

Speed Blink
Monochrome 16 Levels

AGP-3300S STN Color LCD 4096 Colors, 3-Speed Blink 256 Colors
AGP-3300T TFT Color LCD 65536 Colors, No Blink

16384 Colors, 3-Speed 
Blink

256 Colors

AGP-3400S STN Color LCD 4096 Colors, 3-Speed Blink 256 Colors
AGP-3400T TFT Color LCD 65,536 Colors, No Blink

16384 Colors, 3-Speed 
Blink

256 Colors
AGP-3500T

AGP-3500L Monochrome LCD Monochrome, 16 Levels, 3-
Speed Blink

Monochrome 16 Levels

AGP-3500S STN Color LCD 4096 Colors, 3-Speed Blink 256 Colors
AGP-3510T TFT Color LCD 65,536 Colors, No Blink

16,384 Colors, 3-Speed 
Blink

256 Colors
AGP-3560T
AGP-3600T
AGP-3450T
AGP-3550T
AGP-3650T
AGP-3750T
LT-3201A Monochrome LCD 

(Umber)
8 Levels, No Blink Monochrome 8 Levels

PS3651A TFT Color LCD 65,536 Colors, No Blink
16,384 Colors, 3-Speed 
Blink

256 Colors
PS3650A
PS3700A
PS3710A
PS3711A
PS2000B
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Defining Colors
Set the object colors. Depending on part type, setting items such as colors of a border, fill, 
shadow or label, differ depending on the part type.

For a 256-color supported model For a monochrome 16-level supported model

• Objects with the blink setting option blink on the display and have three 
selectable blink speed rates.

 “9.5.2 Setting Blinks” (page 9-37) 
• On monochrome LCD models and STN Color LCD models, when you set a 

tiling pattern in the background settings to use the blink setting, some drawing 
components that do not have the blink setting may blink. Please confirm the 
display in advance.

• For 256-color supported models, you can move to the next palette with the 
scroll button at the bottom of the color palette.

• You can only select [Transparent] for the [Pattern Color] for a Switch Lamp 
that does not use the [Lamp Feature] or for a Key that has a [Pattern] set in 
the settings dialog box.

• When you change from a model that supports more than 16 colors to a model 
that supports only 16 colors, any colors outside the 16 color range are 
converted to one of the 16 colors.

• For a monochrome 16-level model, there are some cases where color 
distinction is difficult or where flicker is caused. Use the color designation 
above after confirming the colors.
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Color Palette
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9.5.2 Setting Blinks

Blink makes the object blink on the display and has three selectable blink speed rates (Slow, 
Medium, Fast).
[Fast] is twice the speed of [Medium] and [Slow] is half the speed of [Medium]. If you select 
[None], the object will not blink.

9.5.3 Setting Line Types

You can select the line type from five types: [Solid Line], [Dotted Line], [Dash Line], [Chain 
Line], or [Two-Dot Chain Line].

9.5.4 Setting Patterns

Select a pattern from the following nine types.

• For dark color blink, refer to  “5.14.6 [System Settings] Setting Guide   
[Display Unit] Settings Guide   Display” (page 5-112) 
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9.6 Editing a Part

9.6.1 Editing Parts

1 From the [Parts (P)] menu, point to [Switch Lamp (C)] and select [Lamp (L)] or click .

2 Move the pointer  to the drawing screen and the pointer changes to a cross-hair cursor 
.

3 Drag to the location where you want to place the switch. The switch is placed in the area 
where it is dragged.

• You can also drag and drop a part from the Parts Toolbox . 
From the [View (V)] menu, point to [Parts Toolbox (T)], [Work Space(W)] 
and select [Parts Toolbox (T)]. The Parts Toolbox appears. You can view 
different parts shapes by setting the [Parts Palette] and [Type].

Lamp 

Edit 

Start 
ON 

Stop 
OFF 
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4 Double-click the placed Lamp and the following dialog box appears.Click the keypad icon 

5 Click the keypad icon  and enter the bit address in the [Input Address] dialog box.
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6 Click the  icon and select the [Device/PLC] and [Device]. Input an address from the 
keypad.(For example, M100)

7 Click [Select Shape] and the [Select State Window] appears.

• Input the address with the keypad on the [Input Address] dialog box. If you 
input it directly with the PC keyboard, it may not be recognized as an 
address.
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8 Select [State 0] and click [Open].

9 Select [Standard Parts] from the Parts Palette. Next select the [Part Number]  
SW_3D202_ OFF picture.

10 Click [OK] and the display returns to the [Select State Window]. Select [State 1] and click 
[Open].

• Use the Parts Palette drop-down list to change the images displayed. There 
are parts with 65536, 256 or 64 colors. Please select the parts palette that 
matches the colors supported by your model.
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11 Select [Standard Parts] from the [Parts Palette]. Next select the [Part Number] 
SW_3D202_ON picture and click [OK].

12 The pictures at [State 0] (OFF) and at [State 1] (ON) are displayed in the [Select State 
Window]. Click [OK].

• Click [Auto] after defining the picture in [State0] to automatically match the 
pictures for all the other states.
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13 Click the [Color] tab. Confirm that [Select State] is OFF and set the color of the switch for 
the OFF state. For the [Display Color], click  and select a color from the color palette.

14 Select ON in [Select State] and set the color of the switch for the ON state.

• You cannot edit the color for the Switch/Lamp menu image parts.

• You cannot edit the color for the Switch/Lamp menu image parts.
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15 Select the [Label] tab. Select [OFF] in [Select State] and input the text to display on the 
switch in the OFF state.

16 Select [ON] in [Select State] and input the text to display on the switch in the ON state. (For 
example, STOP)

17 Click [OK] when all the settings are complete.
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9.6.2 Registering New Part Image

Use the following procedure to register new images for parts.

1 Double-click the part you want to register a new image for, and the following dialog box 
appears. Click [Select Shape].

2 The [Shape Browser] dialog box appears. Click [New Palette].
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3 The [Save As] dialog box appears. Define the [Location(I)] and [File Name (N)] of the new 
parts palette you and click [Save (S)].

4 When the following message appears, click [Yes (Y)].

5 The newly registered [Shape Browser] dialog box appears. Click [Create].
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6 The [Register Parts] dialog box appears. Select [State 0], and click [Select].

7 When the [Open File] dialog box appears, navigate to the image location [Look In], select the 
file [File Name] and [Look in] and [File name] and click [Open].
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8 The image will be registered in [State 0] of the [Register Parts] dialog box.

9 If necessary, set the part number and number of colors for the image to register in [Title] and 
[Color Settings], and click [Register], to complete the process.

• To select an image for the part, open the Parts dialog box and click [Select 
Shape]. 
The [Shape Browser] appears. Select a palette name in [Parts Palette]. Select 
the appropriate image and click [OK].

• If you click "Create" while a previously registered part is selected, you can 
edit that part image. To create a new image, click the "Create" button while 
no previously registered part is selected.

• Image parts can be registered with a maximum size of 160 x 160 dots.
• Parts which use registered images can cause large project file sizes. It is 

recommended you set [Compress] in the [Color].
• You can register up to 200 image parts in a single parts palette file.
• Image parts that have been enlarged or reduced may display differently on 

the GP and in Pro-EX.
• When the registered image size is different depending on the state, the larger 

image will remain the same, and the smaller image will be enlarged.
• You cannot register or delete a previously-prepared PDX file.
• The types of image file that can be registered to a part are BMP, JPEG, DPD, 

and PNG.
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9.6.3 Fixing/Unfixing Objects

Fixing Objects
Place drawings and parts, and a blue fixed pin  appears at the top-left corner objects on the 
screen. Click add space on the pin and it turn red the object cannot be selected or edited. 
When you put the cursor over the object, a "lock" mark appears to the right, indicating that 
the placement position is fixed.)

Releasing Fixed Pins
• Releasing individual objects

Double-click a drawing or part, click  and the pin turns blue.

• Releasing all fixed pins on the screen
From the [Edit (E)] menu, select [Release All Fixed Pins (K)].

Click the blue fixed pin The fixed pin turns red to 
indicate the part is locked
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9.7 Using a Screen for Various Purposes

9.7.1 Setup Procedure

1 From the [Screen (S)] menu, select [New Screen (N)]. The following dialog box appears. 
Click [New] to create a new base screen (Example: Base Screen 2)

2 From the [Draw (D)] menu, select [Call Screen (O)] or click .

B1 

Setting Input Screen Active Operations Screen Active Monitoring Screen Alarm Screen 

B2 

Setting Input Screen Active Operations Screen Active Monitoring Screen Alarm Screen 

B3 

Setting Input Screen Active Operations Screen Active Monitoring Screen Alarm Screen 

Setting Input  
Screen 

Active Operations
Screen

Active Monitoring 
Screen 

B100 

Setting Input Screen Active Operations Screen Active Monitoring Screen Alarm Screen 

Create a screen for various 
purposes. 

You can call and display 
various screens. 

Call Screen 
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3 When you drag on the image screen, a dashed line is drawn. [Call Screen] dialog box is 
displayed.

4 Select the target image from [Call Target].

Base Screens Previously created base screens are displayed.
Image The image data registered in "Image Registration" is displayed.
Image (CF) The CF-card image data registered in "Image Registration" is 

displayed.
Mark Registration Displays registered marks.
Keypad 
Registration

The keypads registered in "Keypad Registration" are displayed.

• When you call a [Base Screen], call and place it in the center of the screen.
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5 Select an image and click [OK] to display the designated image.
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9.8 Editing a Picture on Another Screen

9.8.1 Placing Pictures Registered in the Package

1 Display the registered picture list. From the [View (V)] menu, select [Package (P)].

2 The [Package List] dialog box appears. Select the picture to place and click [Open].

Package

Drag and Drop

Objects registered in 
a package

Place it on the screen and edit it.
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3 The [Package] dialog box is appears. Select a picture and drag it to the drawing screen to 
place it.
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9.8.2 Registering Pictures in the Package

You can register a created object. You can also register a combination of multiple objects.

1 From the [View (V)] menu, select [Package (P)], or click .

2 The [Package List] dialog box appears. Select a package name and click [Open].

3 The [Package] dialog box, which displays a registered package list, appears.

• To register pictures in a new package, click [OK].
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4 Select the figure to be registered and drag to the [Package] dialog box.

5 The pictures have been registered in a package.
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9.9 Creating a Screen from a Template

9.9.1 Setting up Grids

Introduction
You can display a grid with dots or lines on the drawing screen for reference when placing 
multiple objects.
The position of each object is determined according to the intersecting points of the grid, to 
make it easier to adjust the object position. 

Setup Procedure

Display a lined grid on the drawing screen and set the environment for placing an object 
along a line.

• Please refer to the settings guide for details.
 “9.12.2 Preferences [Edit Screen] Setting Guide” (page 9-79) 
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1 From the [View (V)] menu, select [Preferences (O)].

2 The [Preferences] dialog box appears. Select [Screen Edit Style].

3 Set the Action to align objects with intersecting points. Put a check mark next to the [Snap to 
Grid] box. Set the grid spacing in [Grid Size] (by the pixel). (For example, [Width] 20, 
[Height] 20)
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4 In the Display group box, select the [Show Grid] check box. Select [Order] and  [Shape] 
options as necessary. Click [OK] to close the dialog box.
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9.9.2 Selecting a Screen from Template

You can reduce the number of drawing processes by editing in a screen registered in the 
templates.

Placing a Picture Registered in Templates

1 From the [Screen (S)] menu, select [New Screen (N)].

2 The following [New Screen] dialog box appears. Click [Select Template from List].

Select a template. 

Screen Image 3 

Template List 

Screen 
Image 1 

Screen
Image 2

Screen
Image 3

Screen
Image 4

Screen
Image 5

Screen
Image 6
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3 The registered templates display. Select a screen you want to use and click [OK].

4 The template is placed.
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Registering a Screen as a Template
You can register created screens as templates and use them again. To make a screen into a 
template, from the [Screen (S)] menu, select [Register Template (T)]..
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9.10 Pasting an Image

9.10.1 Target Image

Image data that can be displayed on the GP screen is as follows.

Image Pasting Method Description
BMP, JPEG, 
DPD, PNG 
File

Directly placing an 
image on the 
screen

Directly pastes BMP, JPEG, DPD, or PNG on the screen.

• In using the same image on the multiple screens, you can 
hold down the screen capacity by registering the original 
image in "Image".

• You can call the base screen with an image already placed 
onto another base screen.

 “9.10.2 Pasting BMP/JPEG Procedure” (page 9-64) 
Registering an 
image in "Image 
(Display)" and 
using Call Screen

Registers a BMP, JPEG, DPD, or PNG file as the "Image" 
and displays it on the base screen by using Call Screen.

• You can improve screen capacity by registering an image 
file in "Image" and using the same image on the multiple 
screens.

 “9.7 Using a Screen for Various Purposes” (page 9-50) 
Registering an 
image in "Image 
(CF)" and using 
Call Screen

Calls and displays the image data stored in the CF Card on 
the base screen.

 “9.7 Using a Screen for Various Purposes” (page 9-50) 

Calling the base 
screen's image

Calls and displays the base screen's already created image 
data on the base screen.

 “9.7 Using a Screen for Various Purposes” (page 9-50) 
Mark 
Registration

Registered "Mark 
registration" 
images.

Calls and displays the dotted image data registered in 
"Mark" on the base screen.

 “9.11 Drawing a Detailed Picture” (page 9-66) 
Keypad 
Registration

Registered 
"Keypad 
Registration" 
images.

Calls and displays the registered keypad on the base screen.
 “9.7 Using a Screen for Various Purposes” (page 9-50) ]

• You can call one keypad from a [Call Screen] part on a 
Base Screen.
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9.10.2 Pasting BMP/JPEG Procedure

To directly paste the image on the screen:

1 From the [Draw (D)] menu, select [Image Placement (I)], or click the  icon.

2 Move the cursor to the drawing area and the cursor converts to cross hairs. Click the screen 
and the [Open Original File] dialog box appears. Set the [Look in] and [File name] for the 
image to paste.

Converts image data and 
places it on the screen. 

BMP, JPEG, etc. 
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3 Adjust the image quality and number of colors, and click [Open].

4 The following [Image] dialog box appears. Set the size and blink rate for the image to paste.

5 Click [OK] and the designated image will be placed.

• When [Original Size] is selected, an image is placed with the same size as the 
original image. You cannot change the image size after placing it.

• When [Fix Aspect Ratio] is selected, an image is placed with the original 
image horizontal to vertical ratio fixed.
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9.11 Drawing a Detailed Picture

9.11.1 Drawing a Valve

Introduction
You can call and display image data created in a Mark to the base screen. In the [Mark], you 
can draw your own symbols or pictures with dots.

Setup Procedure

To draw a valve with dots:

• Please refer to the settings guide for details.
 “9.12.3 Common (Mark Registration) Settings Guide” (page 9-81) 
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1 From the [Common Settings (R)] menu, click [Mark Registration (M)]. Select [New] and 
enter the [Number] and [Comment] and click [Create] (Example: [Number]1, [Comment] 
Mark Registration)

2 Create an outline of the valve body with a rectangle. From the [Draw (D)] menu, select 
[Filled Rectangle (T)]. Place after dragging to adjust the size and location of the rectangle.

• From the [Edit] menu, click [Undo (U)] to undo the command.
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3 Create a valve opening with an ellipse. From the [Draw] menu, select [Filled Circle/Ellipse], 
Place the object after adjusting the size and location of the ellipse.

4 Create an outline of the valve opening using [Color Inversion]. From the [Edit] menu, select 
[Color Inversion (Y)] to mirror the dot on the campus. In this state, from the [Draw] menu, 
select [Filled Circle/Ellipse] to place after adjusting the size and location of the ellipse. After 
placement, click [Color Inversion (Y)] again to return to the campus state.
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5 Create the handle part with an oval and rectangle. From the [Draw] menu, select [Circle/Oval 
(I)] or [Filled Rectangle (T)]. Place the object after adjusting the size and location of the oval 
and rectangle.

6 Fine tune each part using dots. From the [Draw (D)] menu, select [Dot (D)]. To draw, you can 
click to turn ON (white) and right-click to turn OFF (black).
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7 Click the [Base 1] tab and open a base screen to place the mark. From the [Draw (D)] menu, 
select [Call Screen (O)].

8 Click the drawing screen and the dotted border is placed and the [Call Screen] dialog box 
appears.

• From the [Screen (S)] menu, select [New Screen (N)] to create a new base 
screen.
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9 Select [Mark Registration] from [Call Target] and select the mark number registered in 
[Number]. (For example, 1)

10 Select an image and click [OK] to display the designated image.

• You can designate the display color of the created mark.
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9.11.2 Displaying a Character External to the Character Code

Draw an external character with dots in Mark. You can display registered external characters 
on the screen.
You can register external characters only when selecting the ASCII standard font (bitmap 
font) and the font size of 8 x 16 dots or larger.

Setup Procedure
You can display the created character on the screen by replacing a character in the frame in 
the character code table with it. The following is the procedure for replacing the character ë 
(89h) in the character code table (Code Page 850) with the character "III", which was created 
with dots, and displaying the character "III" on the GP screen.

Character Code List
The following is the character code table of Code Page 850, the character code used on the 
GP.

GPMark Registration

Corresponds to 
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1 From the [Common Settings (R)] menu, select [Mark Registration (M)]. Select [OK] and 
enter the mark number "8010" in the [Number] which corresponds to the character ë (89h) in 
the character code table. Click [New].

 “  Input Code Table” (page 9-76) 

2 Draw a special character. Create "III" to display on the screen.
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3 From the [Draw (D)] menu, select [Base 1] and then select [Text (S)].

4 Place the text on the screen, and double-click it to open the [Text] dialog box.
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5 In the text input area, enter the [Input Code] as "0235", which corresponds to the text code 
(89h), while pressing the [Alt] key. ë has been input. Click [OK].

 “  Input Code Table” (page 9-76) 

• The character placed on the drawing screen is ë. On the screen display of to 
the GP, "III" is displayed.
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How to Display Characters External to the Character Code List
The marks drawn for the mark numbers from 8001 to 8128 are treated as the characters of the 
character codes from 80h to FFh. For example, 8001 corresponds to 80h, and 8002 to 81h.
If you create marks for these mark numbers, they will be registered as external characters.
By inputting the input code corresponding to a mark number on the base screen, the character 
displayed on the base screen is displayed as a registered external character on the GP.

 Input Code Table

8001 
8002 
8003 
8004 
8005 
8006 
8007 
8008 
8009 
8010 
8011 
8012 
8013 
8014 
8015 
8016 
8017 
8018 
8019 
8020 
8021 
8022 
8023 
8024 
8025 
8026 
8027 
8028 
8029 
8030 
8031 
8032 
8033 
8034 
8035 
8036 
8037 
8038 
8039 
8040 
8041 
8042 
8043 
8044 
8045 
8046 
8047 
8048 

 

80h 
81h 
82h 
83h 
84h 
85h 
86h 
87h 
88h 
89h 
8Ah 
8Bh 
8Ch 
8Dh 
8Eh 
8Fh 
90h 
91h 
92h 
93h 
94h 
95h 
96h 
97h 
98h 
99h 
9Ah 
9Bh 
9Ch 
9Dh 
9Eh 
9Fh 
A0h 
A1h 
A2h 
A3h 
A4h 
A5h 
A6h 
A7h 
A8h 
A9h 
AAh 
ABh 
ACh 
ADh 
AEh 
AFh 

0199
0252
0233
0226
0228
0224
0229
0231
0234
0235
0232
0239
0238
0236
0196
0197
0201
0230
0198
0244
0246
0242
0251
0249
0255
0214
0220
0248
0163
0216
0128
0129
0225
0237
0243
0250
0241
0209
0170
0186
0191
0174
0172
0189
0188
0161
0171
0187

8049
8050
8051
8052
8053
8054
8055
8056
8057
8058
8059
8060
8061
8062
8063
8064
8065
8066
8067
8068
8069
8070
8071
8072
8073
8074
8075
8076
8077
8078
8079
8080
8081
8082
8083
8084
8085
8086
8087
8088
8089
8090
8091
8092
8093
8094
8095
8096

B0h
B1h
B2h
B3h
B4h
B5h
B6h
B7h
B8h
B9h
BAh
BBh
BCh
BDh
BEh
BFh
C0h
C1h
C2h
C3h
C4h
C5h
C6h
C7h
C8h
C9h
CAh
CBh
CCh
CDh
CEh
CFh
D0h
D1h
D2h
D3h
D4h
D5h
D6h
D7h
D8h
D9h
DAh
DBh
DCh
DDh
DEh
DFh

0130
0131
0132
0133
0134
0193
0194
0192
0169
0135
0136
0137
0138
0162
0165
0139
0140
0141
0142
0143
0144
0145
0227
0195
0146
0147
0148
0149
0150
0151
0152
0164
0240
0208
0202
0203
0200
0153
0205
0206
0207
0154
0155
0156
0157
0166
0204
0158

8097
8098
8099
8100
8101
8102
8103
8104
8105
8106
8107
8108
8109
8110
8111
8112
8113
8114
8115
8116
8117
8118
8119
8120
8121
8122
8123
8124
8125
8126
8127
8128

E0h
E1h
E2h
E3h
E4h
E5h
E6h
E7h
E8h
E9h
EAh
EBh
ECh
EDh
EEh
EFh
F0h
F1h
F2h
F3h
F4h
F5h
F6h
F7h
F8h
F9h
FAh
FBh
FCh
FDh
FEh
FFh

0211
0223
0212
0210
0245
0213
0181
0254
0222
0218
0219
0217
0253
0221
0175
0180
0173
0177
0159
0190
0182
0167
0215
0184
0176
0168
0183
0185
0179
0178
0247
0160

Mark  
Number 

Mark  
Number 

Text Code
Code Page 851

Input Code
(Alt + Code)

Text Code
Code Page 851

Input Code
(Alt + Code)

Mark  
Number 

Text Code
Code Page 851

Input Code
(Alt + Code)
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9.12 Settings Guide

9.12.1  Text Settings Guide

Setting Description
Direct Text Input text into the Input Text window and place it directly as fixed text.
Text Table Use text from a previously saved Text Table.

 “15.4 Changing Languages (Multilanguage)” (page 15-16) 
Font Type When [Direct Text] is selected:

• Standard Font
You can select a bitmap font from [Japanese], [ASCII], [Chinese 
(Traditional)], [Chinese (Simplified)], or [Korean].

• The standard font will become bitmap font. The display speed is faster 
than with other fonts, but characters may have jagged outlines or 
distorted if enlarged/reduced too much.

• The Japanese and ASCII standard fonts are normally transferred to the 
GP. If you want to use Chinese (Simplified), Korean, or Chinese 
(Traditional) standard fonts, add the language in [System Settings] 
window, [Font] page.

 “6.2 Defining Stroke Font and Standard Font” (page 6-3) 
Continued
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Font Type • Stroke Font
You can select a vector font from [Japanese], [ASCII], [Chinese 
(Traditional)], [Chinese (Simplified)], [Korean], [Cyrillic], or [Thai].

• The standard font will become vector font. Characters are displayed with 
smooth outlines if enlarged, but the display speed is slower than with the 
standard font.

• ASCII stroke fonts are transferred to GP as a normal operation. If you 
want to use Japanese, Chinese (Simplified), Korean, Chinese 
(Traditional), Cyrillic, or Thai stroke fonts, add the language in [System 
Settings/Font].

 “6.2 Defining Stroke Font and Standard Font” (page 6-3) 

• Image Font
Displays a Windows font as bitmap data.

 “6.3 Image Font” (page 6-15) 

When [Text Table] is selected:
Select between Standard Font and Stroke Font.

Display Language Select a text display language from [Japanese], [ASCII], [Chinese 
(Traditional)], [Chinese (Simplified)], [Korean], [Cyrillic], or [Thai].

Direction Select from [Portrait] or [Landscape].
Text Size Select the text size. Each font type has a different size range.

Standard Font: Depending on the font you are using, you can either select 
the font size from [8 x 8 pixel] to [64 x 128 pixel], in increments of 8 pixel 
units, or select a fixed font size, [6 x 10 pixel], [8 x 13 pixel], or [13 x 23 
pixel].
Stroke Font: Select from 6 to 127.

Text Attribute When [Font Type] is [Standard Font] or [Stroke Font], select from the 
following text attributes.
Standard Font: Choose from [Standard], [Bold], [Shadow]

(When using a fixed font size [6 x 10], select from [Standard] or 
[Shadow].)

Stroke Font: Choose from [Standard], [Bold], [Outline]
Alignment When selecting "Vertical", align the center of text with single-byte and 

double-byte characters.
Text Color Set the display color for the text.
Background Color Set the background color for the text.
Shadow Color When the [Font Type] is [Standard Font] and the [Text Attribute] is 

[Shadow], choose a color for the shadow.
Line Spacing Set a value from 0 to 255. This is only applicable when the text is multiple 

lines. This option cannot be used when the [Font Type] is set to [Image 
Font].

Setting Description
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9.12.2 Preferences [Edit Screen] Setting Guide

On the [View (V)] menu, click [Preferences (O)]. The following dialog box appears. Select 
[Screen Edit Style] in the left window.

Setting Description

A
ct

io
n

Guide Display 
on move or 
resize

This function is valid when aligning an object with a previously placed 
object.
Guidelines are displayed at the designated points (the left edge and upper 
edge, etc.).

Snap to Grid The cursor position is determined from the grid size, you don't have to 
fine tune the position.

 “9.9 Creating a Screen from a Template” (page 9-57) 
Grid Size 
(pixels)

Designate the grid interval by the pixel.

Continued
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D
is

pl
ay

Show Fixed 
Pin of Parts

Designate whether or not to show the pin mark when an object is 
selected.

• If you click the pin mark, the Move and Edit Object functions will be 
locked and the pin mark will be red.

Show Ruler Shows rulers at the top and the left side of the screen.

Show Grid Designate whether or not to show a grid.
Show Parts ID Designate whether or not to show the part ID number of the placed part.
Show address Designate whether or not to show the address set to the part.
Show touch 
areas

Designate whether or not to show a touch input valid area.

• Place each object so that the touch areas do not overlap each other.
Show Window 
Parts Screen

Designate whether or not to show a window part screen.

Setting Description
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9.12.3 Common (Mark Registration) Settings Guide

Creating Marks

Setting Description
New Creates a new [Mark Registration] screen.
Open Opens a previously created [Mark Registration] screen.
Number Set the [Mark Registration] screen Number to any value between 1 and 

8,999.
Comment Enter a comment of up to 30 characters for the [Mark Registration] 

screen.
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Open

Setting Description
New Creates a new [Mark Registration] screen.
Open Opens a previously created [Mark Registration] screen.
List of marks Displays the list of the [Mark Registration] screens in the project file.

Number Displays the number of each [Mark Registration] screen.
Comment Displays the comment for each [Mark Registration] screen.

Mark preview Provides a preview display of the marks in the [Mark Registration] 
screen selected in the mark list.

Number Displays the number of the [Mark Registration] screen selected in the 
mark list.

Comment Displays the comment for the [Mark Registration] screen selected in the 
mark list.
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Mark Registration

Setting Description
Preview area Provides a preview display of the mark's on-screen display size.
Drawing area Used to draw marks using the drawing operations below, which can be 

selected from the menu and toolbar.
-[Dot]
-[Line]
-[Rectangle]
-[Circle/Oval]
-[Filled Rectangle]
-[Filled Circle/Ellipse]
-[Fill]
-[Text]
-[Draw Size]
The following items are displayed in the drawing area:
-Origin
-48 x 48 dot grid
-Quadrant (8 x 8 dot area) borders
-Dot ON, Dot OFF (Black), Dot OFF (Transparent)
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9.13 Restrictions

9.13.1 Restrictions for Drawing (Text)

• When text is enlarged or rotated, the thickness of some letters may change.
• For characters with a character code (0x80 to 0xFF), the characters' shape will change due 

to differences in font between GP-Pro EX and the GP.

9.13.2 Restrictions for Pasting BMP/JPEG

• If you set the background color to the screen used for a call screen, the objects placed on 
the screen are not displayed on the GP.

• For a color data image screen, the data capacity is large, but the display speed on the GP is 
fast. For a monochrome data image screen, the display speed on the GP is somewhat slow, 
but the data capacity can be saved. Convert screens depending on the purpose.

• If an image screen is placed beyond the drawing area, the part that is outside the area is 
not displayed on the GP.

• Nesting (calling hierarchy) up to 10-layer (11-fold) is available. However, if the 
remaining memory in the PC decreases in operation, the display on the screen may be 
omitted. When transferred, the nested objects are normally displayed on the GP.
For example, Double-layer (threefold) nesting.

Drawing 
Area

B100 

Call screen B100 Call screen B10 

B10 B1 
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9.13.3 Package Registration Restrictions

• Package register save is executed when you close the GP-Pro EX project.
• Up to 200 objects can be registered in one package. To register more than 200 objects, 

create a new package and register them in a new category.

9.13.4 Restrictions on Marks

• Acknowledge the registered external character after the screen data transmission on the 
display unit. The text corresponding to the input text code is displayed on GP-Pro EX.

• External characters can be registered only when the English standard font with a font size 
of 8 x 16 dot or larger is selected. 8 x 8 dot is not supported.

• To create an external character, draw it with single-byte characters (within 8 x 16 dot) 
with reference to the origin of the mark creating area (0,0).

• External characters cannot be rotated.
• When you print text in Alarm, external characters are not outputted. The results 

depending on printer types are as follows:
For NEC PR201, EPSON ESC/P, HP Laser Jet, and Text ASCII:
Direct code output of the text codes.
For EPSON PM/Stylus:
Image output of Code Page 850 characters

• If you were using the Character code (0x80 to 0xFF) of the Western standard fonts in a 
CSV file while registering external marks, and you want to display the marks in the 
Special Data Display [CSV Display] and [CSV Data Transmission] on GP, they will be 
converted to the external characters that were registered in the mark screen.

9.13.5 Restrictions for Screen Display

• When you reduce the screen edit area with the zoom function, some drawings may not 
display correctly, depending on the magnification.
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